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feature applications - I

3 places for online talking storybooks

browser books, meegenius!, interactive stories for kids

W m Browser Books (bit.ly/AlOwuH) - This website was created to allow
beginning readers to read books on the web. Readers can click
on the friangle on each page to turn the page. If they are unsure

of a word, they can always click on it to hear it read to them. The books have been sorted by level & by

curricular area.

MeeGenius! (meegenius.com/store/books/free) - Is a nice source of free & paid ebooks for B

kids. A neat feature offered is automatic word highlighting to accompany the narration of

each book. This site is also a free app for iPad/iPhone & Android devices. M

MeeGentus!)

The Woodlands Junior School's Interactive Stories for Kids
(bit.ly/MBLVLR) is a school website based in the UK. This site has
educational games for elementary age students, but they also have
a nice collection of links fo free online talking storybooks.

qppi’ric |  www.appitic.com

Need help in finding the right app to use for your studentse APPitic is a great resource for
you to use. Apple Distinguished Educators created this site, & it allows you fo browse for
apps by, SPED/Autism, Preschool, themes (curricular areas), Multfiple Intelligences, Bloom's Revised
Taxonomy, NETS (ISTE's National Education Technology Standards), for teachers, & tools. Most categories
are then refined to smaller categories to search. Since you can look for apps in Multiple Intelligences,
Bloom’'s Taxonomy, & NETS, it helps in finding apps that encourage higher orders of thinking. Each review
over the 1,300 apps listed, gives a thorough descriptfion, devices supported, & a price for the app.



bloomin’ apps | www.schrockguide.net/bloomin-apps.html

Some of you may have heard of Kathy Schrock. She is a well
known educational technologist, with a lot great ideas to bring
technology into the classroom. She is the author of many blogs &
guides to help teachers. She is most commonly known from Kathy
Schrock’s Guide for Educators on Discover School's website
(hitp://school.discoveryeducation.com/schrockguide). Some of
my favorite work of hers is her Bloomin’ Apps, or really Apps to
Support Bloom'’s Revised Taxonomy.

There are four guides over Google, Android, iPad, & Web 2.0
applications that support the 6 levels of Bloom's Revised
Taxonomy (lowest to highest — Remembering, Understanding,
Applying, Analyzing, Evaluating, & Creating). Each guide is
interactive that lists & links the tools to the different levels & tasks
listed in the Taxonomy. The links will take you to either the website,
iTunes Store, or the Droid Marketplace.

Take time to look at all the applications she has listed. It will be able to
YA BLOOMIN’ APPS give you new ideas on how to use or a place to start using these
@ different tools in the classroom.

classtools | www.classtools.net

A few templates on ClassTools have been featured in previous TL4Ts, like the QR Game Generator
Template. There are even more great educational tfemplates available on this site that it had to be
placed as a feature application. ClassTools is a free service for teachers to use to create free
educational games, quizzes, & activities. The templates created using ClassTools can be shared through
email or embedded into a classroom blog. They provide 24 easy to use templates to use with students.

The templates include,

e Fakebook, QR Game Generator, Arcade Game ICI "‘£ I’ !
Generator, Twister, Plagiarizr, & many more! Q” oo .net




V- |

document camera ideas

www.pre-kpages.com/elmo/

Pre-K Pages was designed as a resource for parents & educators of young children &
includes printable products as well as on-site professional development for teachers. A
great resource available is an arficle about document camera classroom uses. Document cameras are
real-time image capture devices for displaying an object to a classroom. They can be over $500 & as
low as $69.

Once you have a document camera, here are some classroom ideas for you to use,
e Word Walls
e Poems & Charts
* ABC Manipulatives
¢ Question of the Day
*  Show & Tell
e & Much more

kerpoof |  www.kerpoof.com

KerPoof is an engaging site with tools to create storybooks, cards, pictures
drawings, & multimedia movies. Use KerPoof for language arts, math, science,
social studies, & more!

Lesson ideas for using KerPoof,

e Creative & journal writing tool
* Animated movies
e Comics with speech bubbles

e Comprehension tool

Teacher Tools: www.kerpoof.com/teach. It's filled with lesson plans & classroom ideas.



mathwire | www.mathwire.com

Mathwire is designed to provide activities & worksheets for teachers. All
material supports a hands-on approach to learning mathematic skills. Also a
bonus, all materials support NCTM Standards. Activities & worksheets are
classroom-tested by feachers & have been modified to reflect this field-testing.

gr code classroom ideas

There are a lot of resources available with lesson ideas for using QR codes in
classrooms. Here a few ideas that are our favorite. They come from a variety of

sources.

10.

11.

12.

Adding QR codes to Word documents for students to check their answers.

Print a QR code on a sticker & place in a textbook atf the relevant point. Pupils scanning the QR
Code are taken to related material, for example a video, web page or source of further information.

Create an "easter egg/scavenger hunt". The students must seek out the QR codes that are posted in
a given area. Use the codes to go to information to answer a question &/or find a clue. Then on to
finding the code.

Add QR codes that lead to book frailers to the backs of library books.
Add QR codes to math worksheets with video tutorials of how fo solve the problems.

In math provide some data on a paper handout with a QR code for an online graphing tool like
Create-a-Graph (http://nces.ed.gov/nceskids/createagraph/).

Stick a QR code wherever there is a child's target (e.g. atf the front of a their text book or on a wall
display). Link fo an audio or video recording explaining what their target is & the steps & strategies to
achieve it.

When learning about money, | know that many of us set up ‘class shops'. Why not add another
dimension to this by pricing up some of the class shop items with QR codes. Children can scan these
to find out the price in the same way that items would have their barcodes scanned at the checkout
of areal shop.

Create an audio or video podcast & create a QR code for students to use 1o listen or watch the
audio or video podcast.

Place QR codes in the outdoor classroom containing information about the tree, plant, insect, or
object while they explore.

Create a math worksheet that has QR codes besides each problem. Upon scanning the code a
step-by-step tutorial is launched in YouTube explaining the process of solving the problem. Students
can use when they are stuck on a particular problem or to check their work.

Stick QR codes in reading books that the children take home. These could link to online
comprehension questions for parents or fo websites that children can use to find out more information
about the books or to related games that they can play.



middle school - I

gaggle | gagglenet G gaggle

A site that is all about online safety for students through monitored email, calendars, homework drop
boxes, message boards, blogs, & digital lockers. Students can edit & collaborate together (using Zoho
online docs), a key piece for 21t century learning. Also included is filfered YouTube access. Gaggle
allows teachers to use fechnology fo communicate with their students, & with easy management &
organization of their classes. One of the great features about Gaggle, it helps students learn how to
communicate using fechnology in a professional manner.

Want more information about using Gaggle with studentse Don't forget about the free webinars at
www.gaggle.net/webinar.

piX|I’ |  pixlr.com pi)(l Y 4

ProTo EDTIAI& SERVICES |

PixIr offers a great set of image creation & editing tools similar to Picnik. Besides their web-based service,
they also have apps for Androids phones & iPhones (PixIr-o-Matic). To top it off they even offer Firefox &
Chrome browser extensions for screen captures (PixIr Grabber).

PixIr Editor is the featured image creation & editing tool. You can create drawings from scratch, & has
options for uploading images or importing images from other places on the web. There is a large
selection of creation & editing tools. There are also options for making multiple layer images, dozens of
filter settings, & of course tools for cropping and resizing images. For a simple quick touch-up or resizing of
an image, there is PixIr Express.
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An Interactive Image

’rhinglink |  www.thinglink.com

Thinglink makes it easy to add photo tags to images on
blogs or websites. Add SoundCloud tags fo images so they
play songs or other sounds. With video tags, visitors can
watch content directly on the image. The basic account
provides the ability to store & tag 50 images.

This work has been reteased Into the

Not quite sure how to use this great tool in a lesson, check
out this Google Presentation — 26+ Ways to Use Thinklink in
the Classroom (bit.ly/KY9dn4). A collaborative doc that is
always growing with ideas, so don't forget to go back o
check out new ideas being added.

“thinglink..



high school

the learning network | learning.blogs.nytimes.com/

An online news site for grades 3-12 from The New York Times. This awesome resource is free for educators
(with registration required). Daily lessons linked to past & present news items, as well as featured links to
various NYT archives. Thought-provoking questions for students to respond to - many classes respond as
part of their class, posting with a handle so their instructor can easily
see which of their students are responding. Excellent resource for
e high school instructors of all subject areas; especially as you work to
The Learning Network incorporate non-fiction reading & writing as part of the Common

Teaching & Learning With The New York Times C ore
ST
pIC|I1'S | www.piclits.com 08 A e B3 Y B

A fun tool pairing visual literacy & text literacy; select a picture & then drag
words based on a concept, theme, story, reflection, etc. They can be as simple
as 5 words or as many as 50. A good tool for encouraging concise writing &
reflection. While an obvious tool for writing poetry & exploring figurative
language, it can be a good way to apply those skills to less obvious subject
areas like science, history, & even math. You can share creations via emaiil,

social media & save them. Be aware that this is not a monitored site but most r -1
content is fine, just a caution for those at the elementary &/or middle school PIC-l |' | 'S
level. L

N I/ NN | H
read-alike websites for all ages

Many people use the "Customers Who Bought This Item Also Bought" feature on Amazon to find new
books based on previous favorites. Read-alike welbsites offer an alternative with variable parameters to
suggest potential new favorites: author, series, genre, title. There are numerous sites with this designation
(ex: if you like Janet Evanovich you might also like J. D. Robb, Rita May Brown or Carl Hiaasen). Pay
attention to how recently the site has been updated.

¢ booksandauthors.wiseto.com/bna/

e bookbrowse.com/read-alikes/

¢ hclib.org/pub/bookspace/FindAGoodBook.cfm

e anniston.lib.al.us/readalikes.htm#name

* www.linc.tas.gov.au/ (Australian library)




stay tuned...

The High School Library will be adding two new resources next year, Rosen Teen Health & Wellness and
Gale/Cengage Culinary Database. There will be several brief fraining sessions at the start of next year - and

some incentives for teachers who incorporate their use into their instruction (don't worry, Mrs. Chou is happy
to help!).

We will also be adding digital audiobook downloads & ebooks (accessible from many devices) to the
collection. Info on these will be provided atf the beginning of next year.
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all learners

bookshare |  www.bookshare.org

Bookshare is an online accessible digital library for books & periodicals for readers with print disabilities. It
is a free service, & has over 127,000 digital books, New York Time best sellers, textbooks, & tfeacher
recommended reading, periodicals, & assistive fechnology tools in ifs collection. As a teacher you need
to register students & provide a proof of disability, & this ensures qualified
individuals use the service. Bookshare serves people with visual
impairments, physical disabilities, & learning disabilities. Bookshare works
on mobile devices, with apps to download, Macs & PCs (with a free

download), & assistive technology devices.

dragon dictation | ipod/ipad app

Books without Barriers

intfo the device's microphone & instantly see your text. A quick way to dictate thoughts for a
story, or to jot down a recap over a topic discussed in class. This application allows users to
share recordings via text message, email, or copy & paste it intfo a note or document. There is
also an editing feature that provides a list of suggested words, just in case Dragon couldn’t
hear over a loud background noise.

(S A free & easy to use app, Dragon Dictation is a voice recognition application. Speak easily

DRAGON

spelling CiTy | www.spellingcity.com/

Spelling City is a website where students insert a spelling list fo study, play games, finish worksheets, & play
other interactive activities. Besides spelling games, Spelling City also offers the capability for students to
type a word and hear it pronounced. There is accessed to teacher resources
such as math & science vocabulary & Dolch-sight word lists. There are word lists
from elementary to high school. There are 14 games included, printables, &
writing practice. The only negative, is unless you sign up for an account, you or
your students would have to enter the words every time you use the site.

VOCABULARY
SPELLINGCITY.COM

11



twu rdy |  www.twurdy.com TW U R DYBETA

Twurdy is search tool that displays the readability of your search. It uses a color-coded system to indicate
how easy or difficult a website is to read. There are three types of searches,

* Just Twurdy - searches using Twurdy's basic algorithm with medium speed & medium results.

* Simple Twurdy - searches using Twurdy's simple algorithm for fast speed but less accurate results.

* Twurdy with Pop - searches using Twurdy's most complex algorithm, which includes looking up the
popularity of words within the text. It has a slower speed with more accurate results.

12



activinspire lessons - I

drag a copy | flipchart: drag a copy
This feature allows you to duplicate an object unlimited % Drag a Co Py G ¥)

number of times. First select an object to bring up the

Marquee Handle. Then click on the Object Edit Menu (the third button in, looks like a mini menu). Finally,
select Drag a Copy. A hand with a plus sign will now appear when you hover over the object. To
remove the Drag a Copy, simply go back into the Object Edit Menu & uncheck it.

Flipchart ideas,

* Periodic table — each element is set to Drag a Copy, & students create or match chemical
compounds.

* Math shapes - give students a shadowed shape, each shape is set to Drag a Copy, & students try
to match the given shadow.

* Morning calendar — days of the week, patterns, or weather icons can be set to Drag a Copy.

* Hundreds, tens, & ones —set ones, tens, & hundreds to Drag a Copy, & students match the
numbers.

miscellaneous tools | flipchart: mixed bag

Here are some miscellaneous tools that may be helpful for you when creating a flipchart.

k. Align Left Align - When you want your page to look orderly, align objects for a clean look.

& Align Centre X Select the objects you want to align; it can be text, shapes, images, efc... Then go fo
=| Align Right the Object Edit Menu (click on the object to bring up the Marquee Handle to find the
T Align Top Object Edit Menu). Under the Object Edit Menu choose Align & then choose your

=f Align Centre Y

<1 Align Bottom alignment. You can align left, right, top, bottom, or along x or y center.

|=/ Align Width

EAlign Height Connector Tool - The Connector Tool can be used fo links in concepts to )
/& Align Angle create cycles, mindmaps, & matching. Once objects are connected, they 18
4 Align Complete will be connected where they move on the page. J

Curve Chain Tool - It allows you to trace a shape on top of an object or to make curves in
v your freeform shapes. It is located under the Shapes Tool. This tool is a good choice when

you need to draw objects with a lof of curves. When you are going to change directions,
do it in small steps so it will look right. It is best to play with this tool before you need it so you
will know how to use it.

13



iﬂ camera tool | flipchart: camera caption

The Camera tool is a great tool that can be used in a lot of different
E} Area Snapshot

ways. The Camera tool is also available by clicking on the Tools icon
in the main toolbox & by clicking Tools > Camera. The Camera tools

can be used for creating a turning part of a PDF or worksheet into a % Point to Point Snapshot
interactive fransparency or whole group practice.

& Freehand Snapshot

There are different settings for the Camera tool,

* Full Screen — Captures the full screen % Window Snapshot
*  Window Snapshot — Captures the Inspire window % Fullscreen Snapshot
* Freehand - Click & drag to draw freehand & make a _/

highlighted area that will be yourimage

* Point to Point — Click & draw to draw straight lines to make a highlighted area that will be your
image

* Area - A highlighted box will appear that will be yourimage

Your snapshot can go to a new page, current page, or be saved to your resources. Just remember that
the Camera tool takes images that cannot be edited.

math tools | flipchart: math tools

Activinspire offers a collection of math tools to choose from. To view the different tools, go to Tools >
Math Tools. To customize your Math Tools, by changing the color & transparency go fo File > Settings >
Tools. Remember, you might want to practice with some of the tools first to get a feel for them.

y Ruler - You can move, angle, & change the measurement units

Set Square - Easily create aright angle, & change the size & degrees

ﬂ Protector — You can move, angle, change from full to half protractor, & either draw an arc,
r closed arc, or a full arc ‘

Compass — You can adjust the height & width, & mirror the Compass / \6

XY Origin — Makes an object rotate around the center of the XY Origin point @

m Dice — Choose up fo 5 dice, the speed of the roll, & output the total of the dice to your flipchart.

Calculator — Choose between the adult or child calculator, & drag & drop the equation from
the calculator to the flipchart.

14



ipod apps

elementary

™ grammar jammers primary edition

For grades K—5,‘co’rchy onimo’re‘d songs & rhymes make Ieor‘ning grammar fun. The music will

have you tapping your toes while the animation unlocks quizzes over grammar usage &
mechanics. There are unique animations & quizzes over the following topics; adjectives, contractions,
nouns, pronouns, punctuation, sentences, & verbs.

love to count by pirate trio

Love to Count by Pirate Trip is designed for children from ages 4 to 7. It is a pirate themed
math games with over 700 math tasks, including infroducing & practicing counting, adding,
subtracting, & ordering. Aimed at infroducing math concepts to students as an enjoyable and
rewarding activity.

MisS g my

miss spell’s class
,spe S

Class A fun word game that has students test their spelling skills against the most commonly
—— misspelled words on Dictionary.com. Students must quickly decide whether each word is
spelled correctly or incorrectly. Speed & accuracy count!

subtracting sardines

@EEE, Students will learn how to solve math subtraction from 1-9 right up to 9-9. They will also count
= from -8 to 8 using visual & verbal skills. This app develops conceptual understanding using 3D
graphics.

15



middle school
Channel One News is a 12-minute news program for middle & high school students. They have

U now created an app that puts Channel One News in students’ hands. Students can watch

the latest video reports & keep up with breaking news, take quizzes, & weigh in on big stories.

channel one news

factor samurai

Similar to the app Fruit Ninja, Factor Samurai takes this concept & turns the fruit info numbers.
Students slice through all numbers that have prime factors. A great way to for students to
practice their times table.

1 flashcards+

This app allows students to easily create & study flashcards. What's even betteris that

Flashcards+ has access o Quizlet.com’s number one rated database of flashcard decks,
which means students may not even need to create a deck & use an already created one for quick
study. Also included is a voice pack that has over 22 different languages & dialects.

presidents vs. aliens

From the creator of Stack the States, Presidents vs. Aliens makes learning about the presidents
fun! Learn facts, quotes, nicknames, & events about different presidents to defeat the aliens
by flinging the presidents at the aliens to knock them down. Flashcards are also provided about all 44
presidents to brush up on presidential knowledge.

16



high school

google translate

Translate words & phrases between more than 60 languages. Just speak your phrase & hear
the corresponding franslation.

musée du louvre

The official application for the world famous Louvre. Discover the museum & the beautiful
Ty artwork housed within. There are over 500 images & details to zoom in from their collections,
along with a presentation of the palace & its history. Welcome to the Louvrel

el focday’s document

ARCHIVES

TODAY'S

el Explore American history 365 days a year, with this app from the National Archives. 365 of the
most fascinating documents & photos from the collections of the US National Archives.
Features documents include; Declaration of Independence & Emancipation Proclamation, also
documents like the Zimmerman Telegram, President Dwight D. Eisenhower’s 1961 Farewell address, & a
handwritten draft of President John F. Kennedy's 1961 Inaugural Address.

vocabology

Help build your students’ vocabulary with this app. View the word of the day from several
Internet sources. Also included a quiz game to test your students’ knowledge with words they
have previously already learned.

17



websites 2 check out - I

doodlebuzz | www.doodlebuzz.com

Draw a line, & watch the results show with DoodleBuzz, a typographic news
explorer. DoodleBuzz is a new way to read the news through an interface
that allows you to create maps of current news stories. Just drag a new
line from a result to see new topics about that result.

59y 08 1,

1%
. 3

logotype maker | htip://logotypemaker.com

Logotype Maker is a free tool for creating your logos. To create a logo just
type in your name or a phrase & Logotype Maker will generate a random
4 selection of logos. You can customize the size,

color, & font style of the logos along with
changing out the logo image. You can also customize logos by uploading
your own PNG image o be used in the logo. If you find logos that you like,
you can download them. This is a great way for students who need create
logos for school projects or reports.

technology integration matrix | http://bit.ly /AtzI4C

The Florida Center for Instructional Technology has a Technology Integration Matrix (TIM) for teachers.
The matrix is a 5x5 grid of suggestions & examples for using technology in a K-12 classroom. The vertical
axis of the matrix refers to characteristics of the earning environment. Those environments are active,
collaborative, constructive, authentic, & goal directed. The horizontal axis of the
grid refers to the level of technology integration into the curriculum. The levels
are, entry, adoption, adaptation, infusion, & fransformation.

To use the TIM, pick a curricular area (math, science, social studies, & language
arts) from a box to watch video examples of using technology in education.
There are video examples for each part of matrix. This TIM could be a great
resource for those who want to use technology in their classrooms, but just aren't
sure how fo get started.
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zoom.it | http://zoom.it ZOOm .it

Zoom.it is a neat web application for displaying large images in blogs, wikis, & websites. Zoom.it creates
a display of your images in a format that allows you to zoom in, zoom out, & scroll around a large image.
To use Zoom.it you need to provide the website with a link to an image on the web, which means the
URLs can be images, web pages, or PDF files. Once you create a zoomable image, just copy the URL
provided & share your image by giving people the direct link to it or by embedding the image into your
blog or website.
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